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President’s Message — 
Official and Freelance Action Kicks Hard at CCRA
By Early Langley, CSR, RMR
CCRA President

From CCRA’s Action Team:  Announcing a grassroots campaign to Save Officials Now, S*O*O*N. Under
the direction of CCRA Board member Brooke Ryan-Henrikson, official in Sacramento County, we will
be contacting every county court reporter's office via in-person meetings, YouTube videos, Skype or
conference call.  Please let us know a contact person for each county you are in.  We will cover these
topics:

1. Word Count: CCRA has contacted stakeholders in this matter, including unions, lobbyists, CAT
software vendors, other associations, and legislative representatives. We are gathering and
analyzing information and developing a strategy.  A plan is in place to meet and confer with the
stakeholders to discuss options for a resolution as quickly and efficiently as possible.   

2. Assembly Bill 2076: Legislation to retain official court reporter fees in local courts.  This will bring
more revenue for court reporter services in our local court.  

3. Assembly Bill 2657: Legislation designed to require transcripts produced by ER machines
designate “unintelligible” or “inaudible.”  This will keep the transcribers “honest” and show the
inaccuracies in the ER transcripts compared to our professional transcripts.  Only live court
reporters can stop the proceedings and ask the parties to restate a word not heard or understood
because of external noise. 

4. JOIN our Action Team’s SAVE OUR OFFICIALS NOW.  

Please e-mail Brooke Ryan at brooke.ryan@cal-ccra.org, or info@cal-ccra.org. 

From the Technology Impact:

1. Technology Impact, a newly formed YouTube series developed by our very own nationally recognized technology
expert and realtime writer Sandy VanderPol.  This series is vital to all of us.  Covered in the series:

a. Clips that feature such distinguished guests as Lesia Mervin and guest speakers from vendors will be
coming out every other week.

b. Windows; realtime streaming of text, audio; realtime commands for attorneys; tips and tricks from master
court reporters; Connectify; wireless realtime; cloud computing; backup of data; and applicable laws in
California governing such issues.  

c. What topics do you want to hear about?  Please e-mail techimpact@cal-ccra.org with your questions and
suggestions!

From the Student Impact:

Our Board member Linda Hart visited the Argonaut School in Sacramento and created a video on Deposition
Procedures.  For information on distribution, please e-mail info@cal-ccra.org.

CCRA is your resource.   We educate the legal and political community on behalf of all court reporters. Our membership
protects, promotes and advocates for the firm owner, the freelancer and official court reporter.   

mailto:info@cal-ccra.org
mailto:techimpact@cal-ccra.org
mailto:info@cal-ccra.org
mailto:brooke.ryan@cal-ccra.org
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Is there anything wrong with a California Certified

Shorthand Reporter putting in the word “inaudible”

in a transcript?  If it is wrong, why shouldn’t a CSR

do that? What codes and Standards of Professional

Conduct and definitions of a CSR apply?

Pursuant to Business and Professions Code section

8017, the practice of shorthand reporting is a

verbatim record of any oral court proceeding,

deposition, court ordered hearing or arbitration, or

proceeding before any grand jury, referee, or court

commissioner and the accurate transcription thereof.

Parenthetical use of ‘inaudible’ in a transcript to

signify that something was said, but the court

reporter did not hear it is unacceptable and could

subject the court reporter to citation and/or discipline

for violating  Business and Professions code section

8025(d) as incompetence (for not informing the

parties that the testimony was inaudible) and for

violating section 8025(j), violation of this chapter or

the statutes, rules, and regulations pertaining to

certified shorthand reporters.  

In addition, the Professional Standards of Practice,

outlined in 16 CCR section 2475(b) (3) require a court

reporter to perform professional services within

his/her scope of competence. The Board interprets

this regulation to further place the duty on a court

reporter to inform parties that testimony is inaudible.

From the Desk of the California Court Reporters Board:
“Inaudible” in transcripts:  Right or Wrong?

Board Members Linda Hart and Pam Katros 
represented CCRA at the Judicial Council Meeting
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Board Member Linda Hart 

Board Member Pam Katros 
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Ask Mr. Modem! — www.MrModem.com

Windows 8: Ready or Not?   

Q. Now that Windows 8 has been released, have

you tried it? If so, what do you think?

A. Windows 8 has not been released commercially yet,
though the Consumer Preview Edition made its
debut on February 29th. As a card-carrying geek
with chronically nerdy tendencies, I have been using
it since that time. Windows 8 introduces many new
features and constitutes a significant change from
Windows 7. I have a few concerns, though overall I
like it. My complete review can be read at
http://bit.ly/yl3RBx.

Q. I am thinking about buying a Kindle or Kindle Fire

reader, in part because I would like to read your

eBooks, but I have a few questions first: What

formats are supported by eReaders? What is the

typical battery life of an eReader? Does using an

eReader hurt one’s eyesight? Thanks, Mr. M.

A. TXT and .PDF files are supported by all eReaders,
as are basic image files such as .GIF and .JPG.
Beyond these fundamental formats, supported
formats vary depending on the eReader. 

As far as the typical battery, displaying pages of a
book in an eReader uses very little power. The most
power is used when turning pages. Battery life is
normally listed as 7,000 to 8,000 page turns, which
would constitute several weeks of heavy reading, or
about 36 minutes if you’re Evelyn Wood. 

Regarding any harm to one’s eyesight, according
to my ophthalmologist, Dr. Jerry “Squinty”
Anderson, absolutely not. In fact, compared to a
computer screen, there is less eyestrain with an
eBook reader because it will generally have a

higher resolution and refresh rate resulting in the
absence of screen flicker. 

Q. I receive the following security warning when I open

my Gmail: “Do you want to view only the Web page

content that was delivered to you securely?” How

can I prevent this from appearing? I’m using

Internet Explorer, if that makes any difference.

A. That type of warning is not emanating from Gmail,
but rather from your browser. Gmail itself has no
strong feelings about what you view. It will be
happy to display anything you click.

You didn’t mention what version of Internet
Explorer you’re using, so try this — and if the
wording isn’t precise for your version, it should be
close enough that you can locate the appropriate
settings: Go to Tools > Internet Options > Security
> Security tab > Custom Level button.

In the Miscellaneous section, change Display
Mixed Content to Enable, then save and exit. That
should take care of it. 

Q. The status bar on my screen is about an inch and

a quarter wide, and I do not know how to make it

smaller. Can you help?

A. By “status bar,” I’m assuming that you mean the
Taskbar — the large bar that appears across the
bottom of the screen. If so, that is designed to
expand or contract, which can come in handy. I
have a very large monitor, for example, so I keep my
Taskbar about three times the normal size so I can
see a multitude of open programs and windows. 

To adjust the size of the Taskbar. First, right-click it
and make sure it shows that it is Unlocked. Then

continued on Page 8

http://bit.ly/yl3RBx
http://www.MrModem.com


place your cursor on the top horizontal edge of the
Taskbar until it (your cursor, not the Taskbar) turns
into a double-headed arrow. 

While pressing the left mouse button, slowly drag
the bar down toward the bottom of the screen and
it will “collapse” incrementally, in steps or tiers, to
the size you want it to be. 

When you’re done, right-click and lock the Taskbar
so it won’t move or change in the future.

Mr. Modem’s DME (Don’t Miss ‘Em) 

Sites of the Month 

Airline On-Time Statistics

Who among us hasn’t had the experience of racing to the
airport to catch a flight, only to get there and wait, and
wait, and wait, and wait… but for how long? If you’re
flying into or out of any airport in North America, you now
have access to statistics that may help answer that
question. The Bureau of Transportation Statistics provides
detailed information regarding airline punctuality, or lack
thereof, current through December 2011.
http://1.usa.gov/aFON6k

Polar Inertia

Polar Inertia is a self-described “Journal of Nomadic and
Popular Culture.” This unusual online magazine is
updated seasonally with visuals that record the 
ever-changing global landscape. My only criticism is
that the default font used on this site is too small and
my bifocals doth protest. If you experience the same
problem, click View > Text Size (or your browser’s
equivalent wording), and increase the size of the
display font.
www.polarinertia.com

Road Sign Math

A fun driving game that bored motorists can play to pass
the time. Read the rules first so you understand what
you’re looking for, then start driving and try to find a
road-sign equation worth submitting to the official Web
site. On the site itself, select a state and when a road
sign’s description appears, click the “Read more” link
located below the description to view the sign and its
mathematical explanation.
www.roadsignmath.com

Mr. Modem’s technology-tips eBooks and award-

winning weekly computer-help newsletter, now in its 12th

year of continuous publication, are available on

www.MrModem.com.

Ask Mr. Modem! — www.MrModem.com

(continued from Page 7)
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Please click on the links below to view the �Examination Statistics — November 1, 2011 Thru February 29, 2012,� and
“Dictation Examination Statistics — February 2012,” for the Court Reporters Board of California.

http://www.courtreportersboard.ca.gov/applicants/examstat_0212.pdf
http://www.courtreportersboard.ca.gov/applicants/examstats_1111_0212.pdf

If you cannot reach the URL by clicking on the above link, please copy and paste it directly into your browser.

The PDF document requires the most current version of Adobe Reader to view. To download click on the following link.
http://get.adobe.com/reader/

From the Court Reporters Board:   
CSR Test Results

http://get.adobe.com/reader/
http://www.courtreportersboard.ca.gov/applicants/examstats_1111_0212.pdf
http://www.courtreportersboard.ca.gov/applicants/examstat_0212.pdf
http://www.MrModem.com
http://www.MrModem.com.
http://www.roadsignmath.com
http://www.polarinertia.com
http://1.usa.gov/aFON6k




AB 1208

(Calderon, Charles [D]) Trial Courts: Administration.

Status: 01/31/2012-In Senate. Read first time. 
To Com. on RLS. for assignment.
Current Location: 01/31/2012-S RLS.

Summary: The bill would prohibit the Judicial Council,
or its designee, from withholding or expending any
portion of the total funds appropriated for trial court
operations by the Legislature for any statewide
information technology or administrative infrastructure
program that was not identified in the annual Budget
Act, unless the Judicial Council, or its designee, first
obtains the written approval of 662/3% of a
proportional representation of all local trial courts. The
bill would require the Judicial Council, or its designee,
to allocate 100% of the funds appropriated for trial
court operations according to each court’s share of
statewide operational funding. Existing law provides
that the Judicial Council retains the ultimate
responsibility to adopt a budget and allocate funding for
the trial courts, as specified, and empowers the Judicial
Council to authorize a trial court to carry unexpended
funds over from one fiscal year to the next. This bill
would delete those provisions and would instead
provide that unexpended funds shall be the funds of
that court, which may carry those funds over from one
fiscal year to the next. The bill would prohibit those
funds from being reallocated or redirected without the
consent of the management of the trial court. 

AB 1582

(Wagner [R]) Civil Actions: Telephone Appearances.

Status: 02/17/2012-Referred to Com. on JUD.
Current Location: 02/17/2012-A JUD.

Summary: Existing law authorizes a court to permit
parties to appear by telephone in designated
conferences, hearings, and proceedings in civil cases
and to require, at its discretion, a personal appearance
in those matters if it would assist in the determination of
the proceedings or in the management or resolution of
the case. Under existing law, the Judicial Council was
required to adopt rules by January 1, 2008, prescribing

the notice for telephonic appearances and the
procedure for conducting those appearances. This bill
would require a court to permit a telephonic
appearance by parties and their attorneys and would
expand the types of hearings, conferences, and
proceedings where those telephonic appearances must
be permitted by the court. The bill would specify that
this requirement is subject to the court's discretion,
which may require a personal appearance under the
circumstances specified in existing law. The bill would
extend the time for the Judicial Council to prescribe the
notice and procedure for telephonic appearances to
July 1, 2013. 

AB 2073

(Silva [R]) Courts: Electronic Filing and 

Service of Documents.

Status: 03/08/2012-Referred to Com. on JUD.
Current Location: 03/08/2012-A JUD.

Summary: This bill would authorize a trial court, by
order and at the discretion of the presiding judge, to
require parties to eligible civil actions, as specified, to
electronically file and serve documents, subject to rules
adopted by the Judicial Council and other specified
conditions. 

AB 2076

(Ma [D]) Official Court Reporter Fee.

Status: 03/08/2012-Referred to Com. on JUD.
Current Location: 03/08/2012-A JUD.

Summary: This bill would permit the court in which the
official court reporter fee was collected to retain that
fee. The bill also would repeal the above-described
reporting requirement of the Judicial Council. 

CCRA Legislation Update 

For information concerning this report or the information contained herein, you may contact California Court
Reporters Association, Attn. Sandy Bunch VanderPol, CSR #3032, at 65 Enterprise, Aliso Viejo, California 92656
(949) 715-4682 or by e-mail at RealtimeCSR@calweb.com. 

Page 10

continued on Page 11

mailto:RealtimeCSR@calweb.com


AB 2119

(Nielsen [R]) Courts: Information Technology Projects.

Status: 02/24/2012-From printer. 
May be heard in committee March 25. 
Current Location: 02/23/2012-A PRINT

Summary: This bill would make nonsubstantive changes
to the provisions requiring review of judicial information
technology projects, including the California Case
Management System, by correcting obsolete cross-
references to the State Chief Information Officer and the
office of the State Chief Information Officer. 

AB 2372

(Hill [D] ) Service of Process: Attorneys.

Status: 03/15/2012-Referred to Com. on JUD.
Current Location: 03/15/2012-A JUD.

Summary: Existing law provides for service of process
and other notices by various means, including by mail or
in person, and specifies the conditions for those various
means of service of process. This bill would provide that,
notwithstanding any other law, service of process by a
client, former client, or officer of the court is effective
upon an attorney if mailed to the address for the
attorney appearing on the attorney’s profile on the
Internet Web site of the State Bar. 

AB 2657

(Calderon, Charles [D] ) Electronic Court Reporting.

Status: 03/19/2012-Referred to Com. on JUD.
Current Location: 03/19/2012-A JUD.

Summary: Existing law regulates official court reporters
in the superior courts. Under existing law, a court may
use electronic recording equipment in a limited civil
case, a misdemeanor or infraction case, or for the
internal purpose of monitoring judicial officer
performance. If electronic recording equipment is used,
a transcript created with that equipment may be used
whenever a transcript of court proceedings is
necessary. This bill would require transcripts created
with electronic recording equipment to designate as
inaudible or unintelligible any sections that cannot be

transcribed verbatim because those sections are not
clearly recorded.

ACR 47

(Davis [D]) Courts: 50th Anniversary of Service by

African American Justices.

Status: 05/11/2011-From committee chair, with author’s
amendments: Amend, and re-refer to committee.
Amended and re-referred to Com. on RLS.
Current Location: 05/11/2011-S RLS.

Summary: This measure would acknowledge the 50th
anniversary of service by African American justices in the
California Courts, and would encourage all Californians
to share in statewide and local celebrations throughout
the year to recognize the contributions and diversity of
these and other judicial trailblazers. The bill would also
call upon the leadership of the judicial, legislative, and
executive branches of government, and the greater legal,
educational, and justice communities, to sponsor and
participate in educational and outreach activities that
highlight the work of the justices of the California Courts
of Appeal and the California Supreme Court. 

SB 326

(Yee [D] ) Court records: public access.

Status: 09/01/2011-From committee with author’s
amendments. Read second time and amended. 
Re-referred to Com. on APPR.
Current Location: 09/01/2011-A APPR.

Summary: Existing law requires the Judicial Council to
adopt rules of court to establish the standards and
guidelines for the creation, maintenance, reproduction,
and preservation of court records, and requires that
these standards and guidelines reflect industry
standards for each medium used, ensure the accuracy
and preserve the integrity of the records, and ensure that
the public can access and reproduce the records.
Specifically, unless access is otherwise restricted by
law, court records created, maintained, preserved, or
reproduced under specified provisions are required to
be made reasonably accessible to all members of the
public for viewing and duplication, and electronic court

CCRA Legislation Update 

(continued from Page 10)
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records must be viewable at the court, whether or not
they are accessible remotely. Additionally, rules of court
require courts to provide public access to electronic
records, as specified. This bill would require the Judicial
Council, in consultation with stakeholder groups, and
within 18 months of the date of enactment of this act, to
adopt a rule of court to require courts that have fully
implemented the California Case Management System
to provide the public, to the extent possible and
practicable, with same-day access to case-initiating civil
and criminal court records, as defined. 

SB 1428

(Blakeslee [R]) Legislative Meetings: 

Recording and Transcription.

Status: 02/27/2012-Read first time. 
Current Location: 02/24/2012-S PRINT

Summary: This bill would require each house of the
Legislature to make an audio, or audio and video,
recording of every open and public meeting of a house
of the Legislature or a committee thereof, and would
require those recordings to be transcribed. The bill
would specify that the transcriptions shall be legislative
records for purposes of the Legislative Open Records
Act and require that the Legislative Counsel make the
transcriptions available to the public in electronic form.
The bill would require each house of the Legislature to
make the transcriptions in a manner that utilizes the best
available technology in audio transcription software in
order to minimize costs. 

SB 1489

(Harman [R]) Courts: Destruction of Court Records.

Status: 02/27/2012-Read first time. 
Current Location: 02/24/2012-S PRINT

Summary: Existing law authorizes the court clerk to
destroy court records after notice of destruction, if there
is no request and order for transfer of the records, upon
the expiration of specified time periods after final
disposition of the case. Court records in capital felony
cases are required to be retained permanently, unless
the charge is disposed of by acquittal or a sentence less

than death, in which circumstance the case is
reclassified and different time periods for retention
apply. This bill would permit the destruction of court
records in capital felony cases one year after the
execution or death of the defendant while awaiting
execution. 

SB 1514

(Anderson [R]) Death Sentences: Automatic Appeal.

Status: 02/27/2012-Read first time. 
Current Location: 02/24/2012-S PRINT

Summary: This bill would remove the automatic appeal
to the State Supreme Court in cases where a judgment
of death is rendered and would instead provide that an
appeal may be taken to an appellate court in the same
manner as an appeal where a judgment of death is not
rendered in a murder case, except as required by the
above provisions of law pertaining to the expeditious
resolution of capital cases. The bill would make
conforming changes. The bill would become operative
only if Senate Constitutional Amendment ____ of the
2011-12 Regular Session is approved by the voters. 

SB 1551

(Vargas [D]) Child Abuse and Neglect: 

Mandated Reporting.

Status: 02/27/2012-Read first time. 
Current Location: 02/24/2012-S PRINT

Summary: Existing law, the Child Abuse Neglect and
Reporting Act, makes certain persons mandated
reporters. Under existing law, mandated reporters are
required to report whenever the mandated reporter, in
his or her professional capacity or within the scope of his
or her employment, has knowledge of or observes a
child whom the mandated reporter knows or reasonably
suspects has been the victim of child abuse or neglect.
Failure of a mandated reporter to report an incident of
known or reasonably suspected child abuse or neglect
is a misdemeanor. This bill would make technical,
nonsubstantive changes to these provisions. 

CCRA Legislation Update 
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SB 1574

(Committee on Judiciary) Discovery: 

Electronically Stored Information.

Status: 03/09/2012-From printer. 
May be acted upon on or after April 8. 
Current Location: 03/08/2012-S PRINT

Summary: The Civil Discovery Act authorizes the use of
certain types of technology, as defined, in conducting
discovery in a complex case. This bill would delete those
provisions, and instead generally provide that when any
method of discovery permits, compels, prevents, or
limits the production, inspection, copying, testing, or
sampling of documents or tangible things, the same
method would also apply to electronically stored
information. The Civil Discovery Act requires any
documents produced in response to an inspection
demand to be produced as they are kept in the usual
course of business, or be organized and labeled to
correspond with the categories in the demand. This bill
would make this provision applicable, in addition, to the
production of electronically stored information. The bill
would also provide that if a party responding to a
demand for production of electronically stored
information objects to a specified form for producing the
information, or if no form is specified in the demand, the
responding party shall state in its response the form in
which it intends to produce each type of information. In

general if a demand for production does not specify a
form or forms for producing a type of electronically
stored information, the responding party would be
required to produce the information in the form or forms
in which it is ordinarily maintained or in a form that is
reasonably usable, but need not produce the same
electronically stored information in more than one form. 

SCR 38

(Price [D]) Courts: 50th Anniversary of Service 

by African American Justices.

Status: 05/02/2011-Referred to Com. on RLS. 
Current Location: 05/02/2011-A RLS.

Summary: This measure would acknowledge the 50th
anniversary of service by African American justices in the
California Courts, and would encourage all Californians
to share in statewide and local celebrations throughout
the year to recognize the contributions and diversity of
these and other judicial trailblazers. The bill would also
call upon the leadership of the judicial, legislative, and
executive branches of government, and the greater legal,
educational, and justice communities, to sponsor and
participate in educational and outreach activities that
highlight the work of the justices of the California Courts
of Appeal and the California Supreme Court.

CCRA Legislation Update
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Make sure that the 3,000 most commonly used words in English are in your CAT dictionary and that you can write them
with as few strokes as possible — preferably one stroke.

http://www.paulnoll.com/Books/Clear-English/English-3000-common-words.html 

From Sue Terry:   

http://www.theglossarist.com

Type in a subject matter and a glossary pops up!

Useful Links:   

http://www.theglossarist.com
http://www.paulnoll.com/Books/Clear-English/English-3000-common-words.html 




ANNE HALL
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PATRICIA HAHN

SABA MCKINLEY

Thank you so much for your generous contributions to sponsor student membership to
CCRA.  These students will benefit from receiving our CCRA Online publication and the

many other programs that we offer to students, some of which require being a member to participate, such as the scholarship
program and being sponsored to the convention.

CCRA Members, if any of you would like to sponsor a student membership, it’s very easy to do so.  Just go to our website, under
the “Students” tab, and click on “Sponsor a Student Membership.”  It only costs $30 and you can pay for it online as well.

Student Corner: 
CCRA Recognizes Student Membership Sponsors

Page 15

continued on Page 16

Free Student Membership recipient

Allen Rose with Linda Hart
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Vocabulary Test No. 10

By Debby Steinman

1.  obsequious - (adj.)   
a. servile
b. arrogant
c. dutiful
d. alert

2. ethos - (noun)    
a. passion
b. ethic
c. ardor
d. esteem

3. complement - (noun)  
a. insult
b. supplement
c. flattering remark
d. dedication

4. venal - (adj.)  
a. conceited
b. angry
c. valiant
d. bribable

5. surcingle - (noun)  
a. ribbon used in 

Olympic dancing
b. tethers for hot air balloons
c. belt to bind a saddle 

to a horse
d. matador’s sash

6. parlous - (adj.)        
a. hazardous
b. secure
c. serious
d. impulsive

7. bucolic - (adj.)         
a. sickly
b. idyllic
c. fussy
d. fearless 

8. milieu - (noun)           
a. mischief
b. environment
c. festivity
d. gathering

9. sheaf - (noun)
a. large amount or number
b. a knife holder
c. a type of woman’s dress
d. tomb

10. ubiquitous - (adj.)                                       
a. uniform
b. oblivious
c. omnipresent
d. incalculable

Answers to Vocabulary Test No. 10:

1. obsequious: (A) marked by or exhibiting a fawning attentiveness; servile

2. ethos: (B) the distinguishing character, sentiment, moral nature, or guiding beliefs of a person, group, or

institution; also ethic

3. complement: (B) something that fills up, completes, or makes perfect; supplement

4. venal: (D) bribable; open to corrupt influence and especially bribery

5. surcingle: (C) belt used to bind a saddle to a horse

6. parlous: (A) hazardous; full of danger or risk 

7. bucolic: (B) idyllic; relating to or typical of rural life 

8. milieu: (B) environment; the physical or social setting in which something occurs or develops  

9. sheaf: (A) large amount or number

10. ubiquitous: (C) omnipresent; existing or being everywhere at the same time

Most of the words for this test came from the Commentary section of the newspaper, civil court hearings and
trials, the Bible, and one came from a fellow reporter.  Enjoy!
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Cal-e-licious
By Gerie Bunch

ASPARAGUS & MUSHROOM SALAD

This is one of my favorites and so simple.

1 bunch of fresh asparagus
1 lb. (10 to 12 med.) mushrooms
½ to ¾ c Nut Tree Dressing (see below)

Bring a large sauce pan of water to a boil. 

Slice asparagus in thin diagonal 1 ½” pieces.

Blanch asparagus for 2 – 3 minutes and put immediately
into a bowl of ice water. When chilled, drain the
asparagus very well.  Slice the mushrooms about 1/8th 

inch thick, at least.  In a medium bowl, combine the
chilled asparagus with the mushrooms and dressing.  
Let marinade for several hours.  This can be served by
itself or on top of a bed of lettuce.

Nut Tree Dressing
In a mortar and pestle grind until smooth the following:
1 ½ tsp. salt
1 tsp. pepper
1 clove garlic

Then add the juice of a lemon (usually ¼ cup)
½ c. red wine vinegar

Whisk together with a small whisk and then pour into a
dressing container.  Add 1 ¼ c. canola or olive oil and 
1 Tbsp. slightly whisked egg white. Shake well.  The egg
white acts as a binding agent to keep it from separating
immediately.

THIS IS OUR FAMILY’S FAVORITE.


